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ABOUT  CHRONOS

Chronos software promotes a dynamic, engaging appreciation of history as you:

- Locate historical data using diverse search tools

- Relate historical facts using timelines and chronology charts

- Create slideshows from the data you have gathered, including text, images, audio, 
video, historical documents and chronology charts that you have created

The slideshows made with Chronos may be presented in class or printed and handed in 
to your teacher.
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START

Chronos alone does not contain any historical data. When you start the software, you 
must also open an archive file provided by your teacher. Think of Chronos as a viewer 
for the history cards contained in this archive that you will use to produce your 
slideshow.

There are three different ways to start Chronos:

- Double-click on the Chronos icon (application icon resembling a stop watch)

- Double-click on the icon resembling a filing cabinet (file extension .arch)
OR
Drag the archive file and drop it onto the Chronos icon

- Double-click on the icon resembling an orange slide (file extension .chr)
OR
Drag the slideshow file and drop it onto the Chronos icon

Method 1 Double-click on the Chronos icon (application icon resembling a 
stop watch)

The Chronos start window prompts you to open an archive file.
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Select: OPEN AN ARCHIVE
 
Using the standard file management window, browse your computer to find the 
archive folder provided by your teacher. In this folder, open the archive file identified 
by an icon resembling a filing cabinet (file extension .arch). 
 
The application opens the INTRODUCTION section. You can explore the content of the 
INTRODUCTION and the archive history cards using the SEARCH tab. For more 
information, consult the INTRODUCTION and SEARCH sections of the Help Guide. 
 
If you want to access the CREATION, MONTAGE and PRESENTATION tabs, you must 
first create a slideshow or open an existing slideshow saved from a previous work 
session. For more information about slideshows, see New Slideshow and Open a 
Slideshow in the MENU BAR section of the Help Guide.
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Method 2 To open the archive, double-click on the icon resembling a filing 
cabinet (file extension .arch) of drag the archive file and drop it onto the 
Chronos icon

The application opens the INTRODUCTION section and the archive’s content loads 
automatically. You can explore the content of the INTRODUCTION and the archive 
history cards using the SEARCH tab. For more information, consult the INTRODUCTION 
and SEARCH sections of the Help Guide. 
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If you want to access the CREATION, MONTAGE and PRESENTATION tabs, you must 
first create a slideshow or open an existing slideshow saved from a previous work 
session. For more information about slideshows, see New Slideshow and Open a 
Slideshow in the MENU BAR section of the Help Guide.
 
*Note: Method 2 will function only if you have previously opened the Chronos 
application. Also, if the ChronosEdit application is installed on your computer, clicking 
directly on the archive file will open the editor rather than Chronos itself.

Method 3 To open a slideshow, double-click on the icon resembling an 
orange slide (file extension .chr) OR Drag the slideshow file and drop it 
onto the Chronos icon

To open an existing slideshow saved from a previous work session, double-click or 
drag and drop the slideshow file onto the Chronos icon. If the archive used to create 
this slideshow has the same name and is in the same location on your computer, the 
content of the archive loads automatically. If not, a dialogue box prompts you to 
locate the archive. When started using Method 3, the application opens the CREATION 
section and the archive's content loads automatically.

*Note: Archive folders covering different historical periods are available from the 
CCDMD. You can also modify an existing archive folder, or create an entirely new one 
using ChronosEdit.
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MENU BAR

The main menu bar is located along the top of your computer screen, except when 
Chronos is in PRESENTATION mode.

*Note: Instructions for use of the menu bar apply to all Chronos functionalities, 
except for the PRESENTATION section.

File Menu

Edit Menu

Window Menu

Help Menu

File Menu

In addition to basic file management commands found in other applications, the File 
menu includes an Import command, which is unique to Chronos.

New slideshow

The New slideshow command creates a slideshow file with an icon resembling an 
orange slide (file extension .chr). When you select New slideshow, a dialogue box 
prompts you to enter the name of your slideshow (a maximum of 26 characters 
followed by the file extension .chr) and specify where to save the slideshow.
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Open a slideshow

The Open a slideshow command allows you to open a slideshow saved during a previous 
work session. A standard dialogue box prompts you to search your computer and open 
a slideshow file with an icon resembling an orange slide (file extension .chr).

Import a slideshow

The Import a slideshow command opens a dialogue box that prompts you to search 
your computer for a slideshow file with an icon resembling an orange slide (file 
extension .chr). 

The software will verify that the slideshow was created using the same archive as the 
one selected for the current work session. If so, it will add the slides of the imported 
slideshow to the current slideshow.

*Note: This operation will not modify the content of your BRIEFCASE.

Save the slideshow

The Save the slideshow command saves the changes made to the slideshow. The name 
of a slideshow can contain a maximum of 26 characters followed by the file extension 
.chr (My-Slideshow.chr, for example).

Save as…

The Save as… command saves the current slideshow under another name. The name 
of a slideshow can contain a maximum of 26 characters followed by the file extension 
.chr (My-Slideshow.chr, for example).

Page Setup

The Page Setup command opens your printer's dialogue box, in which you can define 
the paper size, scale (%) and document orientation (portrait or landscape). Important: 
Slides are larger than the standard US letter format and require landscape orientation 
(and a scale of 72% on Mac OS).
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Print

In the SEARCH section, the Print command allows you to print the list of results found 
using the SEARCH tool. In the CREATION section, the Print command allows you to 
print your slides. Elsewhere, other elements of Chronos can be printed. Refer to 
windows where a printer icon appears, providing several options.

Quit

The Quit command allows you to exit Chronos. Before closing, a dialogue box prompts 
you to save the changes made to your slideshow.

Edit Menu

The Edit menu includes the editing commands that can be found in most word 
processing applications. These commands are only available under certain conditions: 
when the cursor is within an editable text box or table, when a portion of the text is 
selected, when the font size can be modified, or when items in a slide are selected. 
The following sections explain when to use each command.

Undo

The Undo command is only available when the cursor is within an editable text box. It 
allows you to undo the last operation made in that area, such as a text insertion, cut, 
paste, etc.
 
*Note: You cannot Undo the deletion of items in a slide.

Redo

The Redo command is only available when the cursor is within an editable text box. It 
allows you to redo the last operation made in that area, such as a text insertion, cut, 
paste, etc.
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Cut

The Cut command is only available when a portion of editable text is selected, or when 
at least one item (image, media, chronology chart, historical document, or text box) is 
selected in a slide. This command removes the text or deletes selected items.

*Note: Once the Cut command is applied to items in a slide, it cannot be undone.

Copy

The Copy command is only available when a portion of editable text is selected, or 
when at least one item (image, media, chronology chart, historical document, or text 
box) is selected in a slide. This command copies selected text or items for future use 
(see the Paste command).

Paste

The Paste command allows you to retrieve text or items previously stored with the 
Cut or Copy command, and insert them into text boxes or a slide (see the Cut and 
Copy commands). 

Select All

The Select All command allows you to select all the content in a text box, slide, or 
Search Results and BRIEFCASE sections of the SEARCH section. You must first click 
within the area containing the content you wish to select, and then use the Select All 
command.

Enlarge

The Enlarge command is available for most text areas. When this functionality is 
available, the cursor appears as a small magnifying glass with a + sign. Clicking on the 
text will enlarge it in a separate window, which is useful for on-screen presentations in 
class, for example. The Options menu, located on the grey band to the left, allows you 
to zoom in, highlight portions of the text in various colours and draw freehand forms.
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12 (to  24) point

The 12 point to 24 point commands allow you to set the font size of the text in your 
slideshow. The command is applied to both the current text box and all the text boxes 
you subsequently add.

Window Menu

If several windows are displayed (card, vocabulary definition, introductory note, etc.), 
and one is hidden by another, you can bring a window to the foreground by selecting 
its name in the Window menu.

Help Menu

The Help menu includes three commands: Chronos Help, Credits and Comments.

The Chronos Help command opens a window that provides information on the various 
functions of Chronos. You can print the text by clicking on the print button in the 
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lower right corner of the window.

The Credits command provides a list of organizations involved in the production of 
Chronos and individuals who contributed to its development.

The Comments command opens a dialogue box that links to the CCDMD website, where 
you can provide comments and evaluate the quality of the Chronos application.
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INTRODUCTION

You can access the INTRODUCTION section by clicking on the INTRODUCTION tab at the 
top of the main Chronos window. This section provides an overview of the archive that 
was loaded when you started the application. The content of the INTRODUCTION will be 
different for each archive you consult, depending on the selections of the author(s) 
of that archive.

The INTRODUCTION section may include the following:

- The archive title

- A subtitle and/or name(s) of author(s)

- A timeline displaying the historical periods covered in the archive (e.g. 15th 
century, 16th century, 17th century, etc.) with an optional line displaying different 
colours that correspond to longer time periods (e.g. Prehistory, Antiquity, Middle 
Ages, Modern Era, Present, etc.)
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- Drop-down lists for each period, containing the themes defined in the archive. 
Clicking on a theme displays the introductory note for that theme.

- Decorative media, such as an image, audio or video file

- A brief introduction text presenting the archive, software and/or author(s)

For more information, consult the TIMELINE and INTRODUCTORY NOTES sections of 
the Help Guide.
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TIMELINE

In the INTRODUCTION section, the historical periods of the archive are entered on a 
timeline (e.g. 15th century, 16th century, 17th century, etc.) with an optional line 
displaying different colours that correspond to longer time periods (e.g. Prehistory, 
Antiquity, Middle Ages, Modern Era, Present, etc.)
 
Move the cursor over the various items to appreciate the dynamic qualities of the 
timeline.

- Moving the cursor over the orange and brown line displays the dates of each 
historical period

- Moving the cursor over the optional colour line displays the names of historical 
eras

- Moving the cursor over the title box of each period displays a drop-down list of 
themes related to that period

*Note: Drop-down lists will not appear if the author(s) of the archive did not 
include any introductory notes.
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- Clicking on a theme in a drop-down list will display an introductory note, which is a 
brief text introducing the specific historical period and related theme. Clicking on 
terms in red opens a window containing the definition of that term. Clicking on 
topics in green opens the card associated with that topic. It is not necessary to 
close one introductory note in order to access another one. You can click on the 
two drop-down lists at the bottom of the window to navigate between periods and 
themes.

- Clicking on the timeline provides a very different view of the archive periods 
defined in your archive
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INTRODUCTORY NOTES

An archive generally contains introductory notes. These are brief texts introducing a 
specific historical period and related theme. However, if the author(s) of the archive 
did not include any introductory notes, the following instructions will not apply.
 
You can access the INTRODUCTION section by clicking on the INTRODUCTION tab at the 
top of the main Chronos window. Moving the cursor over the title box of each period 
displays a drop-down list of themes related to that period. Finally, clicking on a theme 
in the drop-down list will display the introductory note for that theme.
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You can click on the two drop-down lists at the bottom of the window to navigate 
between periods and themes. The drop-down list on the left displays available periods 
and the one on the right displays available themes.

In both notes and cards, clicking on terms in red opens a window containing the 
definition of that term. Clicking on topics in green opens the card associated with that 
topic. It is not necessary to close one introductory note in order to access another 
one.
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SEARCH

You can access the SEARCH section by clicking on the SEARCH tab at the top of the 
main Chronos window.

This section includes a list of all the cards contained in the archive you opened at the 
beginning of the work session. You can consult these cards and identify those that 
interest you using various search tools. You may then store the cards you wish to 
include in your slideshow using a feature called the BRIEFCASE. 
 
For more information, consult the CARDS, SEARCH TOOLS and BRIEFCASE 
sections of the Help Guide.
 
The SEARCH section includes the following, in order:

- A timeline that shows the historical periods included in the archive when you move 
the cursor over the brown and orange lines

- Search fields for entering or selecting your search criteria (keywords, periods, 
dates and themes)

- Icons to perform a search, reset the search criteria, or print the content of the 
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Search results table

- The Search results table, listing either:
By default, all the cards in the archive
OR
Only those cards corresponding to the search criteria you entered

- Clicking on the title of each column will sort the entries in either ascending or 
descending order, with the exception of the Type column. Clicking on the title of 
the Type column displays a drop-down list of all the card types and subtypes. You 
can select a subtype from this list to refine your search to a specific type of 
card. Double-clicking in the row corresponding to a selected card opens that card.

- The Briefcase is an area in the lower half of the SEARCH section used to store 
the cards you wish to include in your slideshow.

*Note: This feature is only available once you have created a new slideshow or 
opened an existing one. Simply drag the selected files from the Search results 
table to the Briefcase.
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SEARCH TOOLS

Search fields for entering or selecting your search criteria (keywords, periods, dates 
and themes) are located at the top of the SEARCH section, just below the timeline.

Keywords

- Enter the keyword of your choice by typing it in the search box

- Enter multiple keywords, separated by the expression ‹AND›

- Enter the card code to find a specific card (fx-12, for instance)

- Select a keyword from the drop-down list by clicking on the arrow at the right of 
the search box

Per iods
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- Enter the name of a historical period included in the archive by typing it in the 
search box

- Enter multiple periods, separated by the expression ‹AND›

- Select a period from the drop-down list by clicking on the arrow at the right of 
the search box

Date

- Enter a single date in the first or second search box

- Enter a date in each search box to create an interval

Themes

- Enter the name of a theme included in the archive by typing it in the search box

- Enter multiple themes, separated by the expression ‹AND›

- Select a theme from the drop-down list by clicking the arrow at the right of the 
search box

Once you have entered all your search criteria, click on the magnifying glass. A popup 
menu prompts you to choose between:

- Search all fields
- Search specific fields

If you choose Search specific fields, a second dialogue box displays the following 
options:
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The Search results table displays the number of cards found that correspond to the 
criteria you entered, followed by a list of all the cards. The header of the Search 
results table allows you to sort the entries by card Code, Title, date (From/To 
columns) and Type. There is also a column labeled Chronology?, which indicates 
whether or not the card may be included in a chronology chart in your slideshow. 
Clicking on the title of each column will sort the entries in either ascending or 
descending order, with the exception of the Type column. Clicking on the title of the 
Type column displays a drop-down list of all the card types and subtypes. You can 
select a subtype from this list to refine your search to a specific type of card.

To reset the search criteria and display the default list of all the cards in the archive, 
click on the reset button (icon resembling two circular arrows).
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CARDS

The Search results table in the SEARCH section displays a list of all the cards 
contained in the archive you opened at the beginning of the work session. 
Double-clicking on a row opens the corresponding card.
 
There are five types of cards: Document Cards, Chronology Cards, Image Cards, 
Audiovisual Cards, and Multimedia Cards.

Shared Characteristics of Cards

Document Cards

Chronology Cards

Image Cards

Audiovisual Cards

Multimedia Cards

Shared Characteristics of Cards

Despite their differences, all of the cards have some characteristics in common.
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- Dark orange header indicating card type and subtype, where applicable; card code; 
author(s) signature(s)

- Close button (X) in the upper right corner

- Title and subtitle

- Descriptive text, generally located on the right, with the exception of Multimedia 
cards, where it is located on the left. To enlarge this text, click on it while holding 
down one of the following keys: Shift, <CTRL> or <ALT>

- Interactive timeline that situates the events described on a specific card within 
the general timeline of the entire archive. The line varies from card to card — 
move the cursor over it to discover its dynamic qualities

- Button with an icon resembling a BRIEFCASE to add or remove a card from the 
BRIEFCASE. When the card is added to the BRIEFCASE, the icon becomes orange.
*Note: This feature is only available once you have created a new slideshow or 
opened an existing one.

- Print button (icon resembling a printer) to:
Print the card
OR
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Print detailed info from card

- History button (icon resembling three horizontal lines), which displays your 
navigation history

- Button with an icon resembling a flip chart (Previous Card and Next Card) to 
navigate quickly between cards without closing the window or returning to the 
Search results table. To the right of this button, the number indicates the 
position of the current card in relation to all the cards in the Search results table.

Document Cards

The main component of a Document Card is the area resembling a piece of parchment, 
located to the left of the card's descriptive text. The parchment contains a historical 
document, such as a letter, poem, personal account, sermon, law, treaty, etc.). Click 
on the document text to enlarge it.
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Chronology Cards

The main component of a Chronology Card is a chronology chart of parallel events and 
historical facts, located to the left of the card's descriptive text. Moving the cursor 
over each timeline included in the chronology chart enlarges the timeline title. Clicking 
on a specific timeline in the chronology chart opens the corresponding source card.

Image Cards

The main component of an Image Card is an image, located to the left of the card's 
descriptive text. The image may be a historical map, work of art, picture of an 
artifact, portrait, etc. Clicking on the image enlarges it to its maximum size.

- 2 6 -



 (17/06/09 10:39)

Audiovisual Cards

The main component of an Audiovisual Card is a Play media button, located to the left 
of the card's descriptive text. Clicking on the Play media button plays an audio or 
video file, such as a piece of music, narration of a personal account or poem, video, 
etc. 

- 2 7 -



 (17/06/09 10:39)

Multimedia Cards

The main component of a Multimedia Card is the descriptive text, which differs from 
other card types in that it is generally located on the upper left. The size of the text 
box may vary according to the preference of the archive author(s) and may even 
occupy the entire card. The descriptive text includes specific content developed by 
the author(s), such as the biography of a historical figure, the description of an 
event, the development of a specific topic, etc.
 
A Multimedia Card is also unique in that it may include an indefinite number of other 
items in addition to the descriptive text, including:

- Images
- Media
- Historical documents
- Chronology charts and timelines
- Additional text boxes
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A Multimedia Card includes various features:

- Clicking on an image, chronology chart or historical document enlarges it

- Clicking on the Play media button plays an audio or video file

- Clicking on one of the items in a card while holding down the Shift key
> Enlarges the content of a text box
> Displays the source card of the specific item selected, including images, 
chronology charts, historical documents and media

*Note: The history button (icon resembling three horizontal lines) at the bottom of 
the card displays your navigation history and allows you to move easily between the 
cards you have consulted. For more information on the history button, consult the 
Shared Characteristics of Cards section of the Help Guide.
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BR IEFCASE

The BRIEFCASE is the area used to store the cards you wish to include in your 
slideshow. 

Where to Find the Briefcase

Add Cards to the Briefcase

Remove Cards from the Briefcase

Review the Content of the Briefcase

Reduce or Enlarge the Size of the Briefcase

Use Cards in the Briefcase to Create a Slide

Where to Find the Briefcase

You will find the Briefcase in the SEARCH section, directly under the Search results 
table. This is usually where you will add or remove cards.
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You can also access the Briefcase in the CREATION section by:

Clicking on the Briefcase button at the bottom of the floating toolbar
OR
Double-clicking on a slide item (Image, Media, Chart, Document, or Text box) 
 

In the CREATION section, the Briefcase is primarily used to help you create your slides.
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Add Cards to the Briefcase

There are two methods for adding cards to the Briefcase:

- Method 1 From the SEARCH section
Select one or more cards in the Search results table and drag them into the 
Briefcase area below.

*Note: This feature is only available once you have created a new slideshow or 
opened an existing one. If this is not the case, a dialogue box will prompt you to 
either create or open a slideshow before proceeding.

- Method 2 When a card is in the foreground of your computer screen
Click on the Briefcase button in the lower right corner of the card. The interior of 
this icon becomes orange when the card is added to the Briefcase.

*Note: This feature is only available once you have created a new slideshow or 
opened an existing one.
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Remove Cards from the Briefcase

There are three methods for removing cards from the Briefcase:

- Method 1 From the SEARCH section
Select one or more cards in the Briefcase area and either press the delete key on 
your keyboard, or click on the Briefcase button on the title bar to choose between 
the following actions:
> Remove the selected card from the Briefcase
> Remove all cards from the Briefcase

- Method 2 When a card is in the foreground of your computer screen
The interior of the Briefcase button will be orange if the card is already contained 
in the Briefcase. Clicking on the button will remove the card from the Briefcase 
and the orange colour will disappear.

- Method 3 From the CREATION section
Open the Briefcase section by clicking on the Briefcase button at the bottom of 
the floating toolbar. Select a card and either press the delete key on your 
keyboard or click on the minus button (-) in the upper right corner of the 
Briefcase window.

Review the Content of the Briefcase

There are two methods for reviewing the content of the Briefcase:

- Method 1 From the SEARCH section
Double-click on any row of the BRIEFCASE to open the corresponding card

- Method 2 From the CREATION section
Open the Briefcase section by clicking on the Briefcase button at the bottom of 
the floating toolbar. Selecting a card in the Briefcase section displays an overview 
of its content in the lower portion of the window.
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Reduce or Enlarge the Size of the Briefcase

There are two methods for reducing or enlarging the size of the Briefcase

- Method 1 From the SEARCH section
Move the cursor directly over the uppermost horizontal border on the Briefcase 
title bar (thin, dark brown line). The cursor will change to two short horizontal 
lines with arrows pointing up and down. Click and hold down the mouse button, 
then drag the border to change the size of the Briefcase area.

- Method 2 From the CREATION section
Open the Briefcase section by clicking on the Briefcase button at the bottom of 
the floating toolbar. Click on the small triangle located in the lower left corner to 
reduce or enlarge the window.

Use Cards in the Briefcase to Create a Slide

Double-clicking on an empty slide item opens the Briefcase and allows you to select or 
search for cards to add.

*Note: You will see only the cards that correspond to the type of item you selected, 
and the Briefcase will display only the cards you have previously saved. For example, if 
you wish to add an image but have not saved any Image Cards in your Briefcase, the 
list will be empty and you will not be able to add this type of card/file.

For more information, see SLIDES in the CREATION section of the Help Guide. 
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CREATION

You can access the CREATION section by clicking on the CREATION tab at the top of 
the main Chronos window.

From the CREATION section, you create and edit the slides in your slideshow. The Title 
Page is the default slide of a new slideshow. It is the first slide you see when you open 
the CREATION section. This slide cannot be deleted or moved. For more information, 
consult the TITLE PAGE, TOOLBAR and SLIDES sections of the Help Guide.
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TITLE PAGE

The Title Page is the default slide of a new slideshow. It is the first slide you see when 
you open the CREATION section. This slide cannot be deleted or moved.

Title Page Content

Editing the Title Page

Title Page Content

The Title Page includes the following, in order:

- A title

- A subtitle

- Slideshow Author(s) Name(s) 
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- Educational Institution

- Slideshow Creation Date

- Optional Introduction

- Timeline illustrating the historical periods covered by the archive, as well as a 
timeline illustrating the specific periods covered in the slideshow

- Optional media (image, audio or video)

There are several buttons in the lower right corner of the CREATION section:

- EDIT button (icon resembling a text editing cursor and the letter “e”) to edit the 
content of the slide

- PRINT button (icon resembling a printer) to print the content of the current slide 
or all slides

- HISTORY button (icon resembling three horizontal lines) to display your navigation 
history

- Button with an icon resembling a flip chart (Previous Slide and Next Slide) to 
navigate quickly between slides. To the right of this button, the number (above 
the line) indicates the position of the current slide in relation to the total number 
of slides in the slideshow (below the line).

*Note: You can select the number above the line, replace it with the number of a 
desired slide, and press Enter on your keyboard to go directly to that slide.

Editing the Title Page

To modify the content of the Title Page, click on the EDIT button (icon resembling a 
text editing cursor and the letter “e”).
 
The EDIT window opens:
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Enter the details of your slideshow into the text boxes displayed in the EDIT window 
(title, subtitle, slideshow author(s), group, institution, date, and comment.)

*Note 1: The slideshow creation date appears by default but can be changed. You can 
also add a short introductory text and one sample of decorative media (image, audio 
or video) from the archive's image and media files. When you have finished entering 
the information for the Title Page, click on OK in the lower right corner of the window.

*Note 2: It is important to save your work frequently using the File menu when 
alternating between CREATION and PRESENTATION modes, to avoid losing content due 
to a malfunctioning media file.
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TOOLBAR

The Toolbar appears when the CREATION section is open. It floats in the foreground of 
your computer screen and can be moved around at your convenience. The Toolbar is 
used to add, delete and create slides, and display the content of your Briefcase. For 
more information on adding slide items using the Toolbar, consult the SLIDES section 
of the Help Guide. 

*Note: The Toolbar cannot be used to edit the Title Page slide. For more information, 
see Editing the Title Page in the Help Guide.

Toolbar Buttons

Use the first two buttons on the Toolbar to add + or delete - a slide.

The remaining five buttons are used to create a slide by adding items to it. Select the 
desired type of item by grabbing the corresponding button on the Toolbar and 
dragging it onto the slide. An empty object associated with that particular type of 
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item opens in the slide.

Double-clicking on the empty object opens the Briefcase and allows you to select or 
search for slide items to add.

*Note: You can only select a card previously saved in your Briefcase. For example, if 
you wish to add an image but have not saved any Image Cards in your Briefcase, the 
list will be empty and you will not be able to add this type of item.

Detailed explanations of the five buttons

The IMAGE button (rectangular icon with a dot in the centre) inserts an image holder 
in the slide. By default, the image holder is an empty square with four shaded corners.

To replace this object with an image, double-click on the image holder to open the 
Briefcase, which will display only the Image Cards you have previously saved.

*Note: If you have not saved any Image Cards in your Briefcase, the list will be empty 
and you will not be able to add this type of item.
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Click on the card of your choice; the image and an overview will appear in the lower 
portion of the Briefcase section. Click on OK and the image will replace the image 
holder in your slide. 
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Click and hold down the mouse button to drag the image to a different position in the 
slide. To resize the image, grab one of the red handles along the edges or in the 
corners, and move it in or out to the desired size. The image will retain its proportions 
regardless of its size.

The MEDIA button (icon resembling a movie clapboard) inserts a media selection tool 
in the slide. The object resembles a small arrow with the label Choose media.

To replace this object with a media file, double-click on the small arrow to open the 
Briefcase, which will display only the media cards you have previously saved.

*Note: If you have not saved any media cards in your Briefcase, the list will be empty 
and you will not be able to add this type of item.
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Click on the card of your choice; the media file and an overview will appear in the lower 
portion of the Briefcase section. You can test the media by clicking on the button Play 
media. To insert the media in your slide, click on OK and the media selection tool will 
become a Play media button.
 
Move the cursor over the button to see the title of the media in a text box. Click and 
hold down the mouse button to drag the Play media button to a different position in 
the slide.
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The DOCUMENT button (icon resembling a quill and inkpot) inserts a document holder 
in the slide. By default, the document holder is an empty parchment.
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To replace this object with a document, double-click on the parchment to open the 
Briefcase, which will display only the Document Cards you have previously saved.

*Note: If you have not saved any Document Cards in your Briefcase, the list will be 
empty and you will not be able to add this type of item.

Click on the card of your choice; the document and an overview will appear in the lower 
portion of the Briefcase section. Click on OK and the document text will appear on the 
parchment in your slide. 

Click and hold down the mouse button to drag the document to a different position in 
the slide. To resize the document, grab one of the red handles along the edges or in 
the corners, and move it in or out to the desired size.
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The CHART button (icon resembling an hourglass) inserts an empty chronology chart 
in the slide. By default, the chart is a big blank rectangle with a scrollbar on the right 
side.
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Double-click on the rectangle to open the Briefcase, which will display only the cards 
you previously saved that can be used to build a chronology chart.

*Note: If you have not saved any such cards in your Briefcase, the list will be empty 
and you will not be able to add this type of item.

The Briefcase displays two tables; the upper table contains the cards you have 
already saved, while the lower table is empty. Drag the cards you wish to include in 
your chronology chart from the upper to the lower table, placing them in ascending 
chronological order. The SEARCH tool can help you locate cards to include in your 
chart from among those you have previously saved. Click on OK and the timelines 
associated with each card will be inserted into the chronology chart in your slide.

If you wish to adjust the display, double-click on the chart to return to the Briefcase, 
where you can easily switch the order of the timelines by dragging the cards into 
different positions in the list. 

*Note: The chart can be dragged to a different position in the slide but cannot be 
resized. 

- 4 7 -



 (17/06/09 10:39)

The TEXT button (icon with five horizontal lines) inserts a text box in the slide. By 
default, this box contains only the word Text. Double-click on the word Text to replace 
it with your own text, either by typing directly into the box or copying and pasting 
text from another document.
 
To select the entire text box, click on the outer edge to display the red handles. You 
can then drag the text box to a different position in the slide, or grab one of the red 
handles to change its size. You can also use the Edit menu in the main menu bar to 
modify text in this area. For more information, see Edit Menu in the MENU BAR 
section of the Help Guide
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The BRIEFCASE button is the last button on the floating Toolbar. It opens the 
Briefcase, allowing you to view or remove cards.
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SL IDES

When you add a new slide (by clicking on the + button on the toolbar), the slide 
displays the following default content:

- Untitled Slide D-#

- Subtitle

There are several buttons in the lower right corner of the CREATION section:

- EDIT button (icon resembling a text editing cursor and the letter “e”) to edit the 
content of the slide

- PRINT button (icon resembling a printer) to print the content of the current slide 
or all slides

- HISTORY button (icon resembling three horizontal lines) to display your navigation 
history

- Button with an icon resembling a flip chart (Previous Slide and Next Slide) to 
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navigate quickly between slides. To the right of this button, the number (above 
the line) indicates the position of the current slide in relation to the total number 
of slides in the slideshow (below the line).

*Note: You can select the number above the line, replace it with the number of a 
desired slide, and press Enter on your keyboard to go directly to that slide.

Once you have inserted items in a slide (Image, Media, Chart, Document, or Text box), 
you can do the following:

- Click on an item to select it. When you select an item, red handles appear along its 
edges.

- Select multiple items by:
> Clicking on each item while holding down the Shift key 
> Clicking on the slide background, holding down the mouse button and dragging 
the cursor over each item
> Using the Select All command in the Edit menu

- Move selected items by:
> Clicking on one of the selected items to drag the group of items to a different 
position
> Using the arrow keys on your keyboard to move the group one pixel at a time in 
any direction
> Using a combination of the arrow keys and the Shift key to move the group 10 
pixels at a time in any direction

- Resize a selected item by dragging one of the red handles along its edges.

*Note: MEDIA and CHART items cannot be resized.

- Remove selected items by:
> Pressing the Delete key 
> Using the Cut command in the Edit menu

- Copy selected items by using the Paste command in the Edit menu.
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MONTAGE

Use the MONTAGE section to organize your slides and finalize your slideshow.

To move a slide, hold down the mouse button and drag the slide to its new position. 
The other slides will move over accordingly. To modify a slide, double-click on it to 
open the CREATION section, where you can edit or delete the slide in question.
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PRESENTATION

The PRESENTATION section allows you to view your slideshow. The slides are 
presented in the order defined in the MONTAGE section. The first slide is always the 
TITLE PAGE of the slideshow.

To go from one slide to the next during the presentation, you can:

- Use the arrow keys on the keyboard

- Click near the right or left edges of the slide (the cursor will take the form of a 
Next or Previous arrow) 

- Mouse over the lower right corner of the slide to display several buttons:
> Options 
> History
> Previous slide
> Next slide

When a slide is displayed, you can:

- Click on the images to enlarge them
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- Click on text boxes and documents to enlarge them. In addition, when a text box 
or historical document is enlarged, an Options menu provides various tools for use 
during the presentation (Enlarge, Reduce, Pencil, Marker, Freehand forms, Text 
highlight).
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- Enlarge Chronology Chart and Timeline text by moving the cursor over the text

- Play the media by clicking the Play media button

- Exit the presentation by:
> Pressing the Escape key on the keyboard
> Using the End the slideshow command in the Options menu in the lower right 
corner of the slide
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